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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a
condition fully complying with safety standards. To maintain this condition and to ensure safe operation,
you must observe all instructions and warnings provided in this manual. If you have any questions
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer
them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any intention other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and a basic knowledge of English. It is therefore essential that only
skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the
product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at
the appropriate place in the product documentation. Keep the basic safety instructions and the product
documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories.

Symbols and safety labels

A A&AMNAASG BN L

Notice, general Caution Danger of Warning! PE terminal Ground Ground Be careful when
danger location when electric Hot surface terminal handling
handling shock electrostatic
Observe prqduct heavy sensitive
documentation equipment devices

| O D — ~ ~ O

ON/OFF supply | Standby Direct current Alternating current | Direct/alternating | Device fully protected by
voltage indication (DC) (AC) current (DC/AC) double (reinforced) insulation
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Basic Safety Instructions

Tags and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks
and dangers.

indicates a hazardous situation which, if not avoided, will result in death or
A DANGER serious injury.

indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A WARNING

indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

indicates the possibility of incorrect operation which can result in damage to
NOTICE the product.

In the product documentation, the word ATTENTION is used synonymously.

A CAUTION

These tags are in accordance with the standard definition for civil applications in the European Economic
Area. Definitions that deviate from the standard definition may also exist in other economic areas or
military applications. It is therefore essential to make sure that the tags described here are always used
only in connection with the related product documentation and the related product. The use of tags in
connection with unrelated products or documentation can result in misinterpretation and in personal injury
or material damage.

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, pollution
severity 2, overvoltage category 2, use only indoors, max. operating altitude 2000 m above sea level,
max. transport altitude 4500 m above sea level. A tolerance of £10 % shall apply to the nominal
voltage and +5 % to the nominal frequency.

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
death.

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
death.
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Basic Safety Instructions

Electrical safety

If the information on electrical safety is not observed either at all to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

2. Inthe case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with an earthing contact and protective earth connection.

3. Intentionally breaking the protective earth connection either in the feed line or in the product itself is
not permitted. Doing so can result in the danger of an electric shock from the product. If extension
cords or connector strips are implemented, they must be checked on a regular basis to ensure that
they are safe to use.

4. If the product does not have a power switch for disconnection from the AC supply network, the plug of
the connecting cable is regarded as the disconnecting device. In such cases, always ensure that the
power plug is easily reachable and accessible at all times (corresponding to the length of connecting
cable, approx. 2 m). Functional or electronic switches are not suitable for providing disconnection from
the AC supply network. If products without power switches are integrated into racks or systems, a
disconnecting device must be provided at the system level.

5. Never use the product if the power cable is damaged. Check the power cable on a regular basis to
ensure that it is in proper operating condition. By taking appropriate safety measures and carefully
laying the power cable, you can ensure that the cable will not be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.

6. The product may be operated only from TN/TT supply networks fused with max. 16 A (higher fuse
only after consulting with the Rohde & Schwarz group of companies).

7. Do notinsert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket. Otherwise, sparks that result in fire and/or injuries may occur.

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

9. For measurements in circuits with voltages Vs > 30 V, suitable measures (e.g. appropriate
measuring equipment, fusing, current limiting, electrical separation, insulation) should be taken to
avoid any hazards.

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply
in each case.

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

12. If a product is to be permanently installed, the connection between the PE terminal on site and the
product's PE conductor must be made first before any other connection is made. The product may be
installed and connected only by a licensed electrician.

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fused in such a way that anyone who has access to the product, as
well as the product itself, is adequately protected from injury or damage.
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14.

15.

16.

17.

18.

Basic Safety Instructions

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1. Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.

Before you move or transport the product, read and observe the section titled "Transport".

As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal", item 1.

Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz product, absolutely no
other settings or functions may be used as described in the product documentation. The objective is to
prevent personal injury (e.g. due to laser beams).
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Basic Safety Instructions

Repair and service

1.

The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, PE conductor test, insulation
resistance measurement, leakage current measurement, functional test). This helps ensure the
continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box orin a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Keep cells and batteries out of the hands of children. If a cell or a battery has been swallowed, seek
medical aid immediately.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.
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Informaciones elementales de seguridad

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.

Waste disposal

1. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

2. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

Informaciones elementales de seguridad

Es imprescindible leer y observar las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
adjunto de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario
debera atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de
empresas Rohde & Schwarz esta siempre a su disposicion en caso de que tengan preguntas referentes a
estas informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
estd destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Informaciones elementales de seguridad

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacion del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccién de personas, que encontraran en el capitulo correspondiente de la
documentacion del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios.

Simbolos y definiciones de seguridad

1 (i) 1

18 kg —
Aviso: punto de Atencién en Peligro de Adver- Conexién a Conexion | Conexién Aviso: Cuidado
peligro general el manejo de | choque tencia: conductor de | a tierra amasa en el manejo de
dispositivos eléctrico superficie proteccion dispositivos
Observar la o, de peso caliente sensibles a la
documentacion elevado electrostatica

del producto

(ESD)
| O <D —— N TN D
Tension de Indicacion de Corriente Corriente alterna | Corriente El aparato esta protegido
alimentacion de estado de continua (DC) (AC) continua / en su totalidad por un
PUESTAEN espera Corriente alterna | aislamiento doble
MARCHA / (Standby) (DC/AC) (reforzado)
PARADA
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Informaciones elementales de seguridad

Palabras de seiial y su significado

En la documentacion del producto se utilizan las siguientes palabras de sefal con el fin de advertir contra
riesgos y peligros.

PELIGRO identifica un peligro inminente con riesgo elevado que
A PELIGRO provocara muerte o lesiones graves si no se evita.
ADVERTENCIA identifica un posible peligro con riesgo medio de
A ADVERTENCIA provocar muerte o lesiones (graves) si no se evita.

ATENCION identifica un peligro con riesgo reducido de provocar

A ATENCION lesiones leves o0 moderadas si no se evita.
AVISO indica la posibilidad de utilizar mal el producto y, como
m consecuencia, danarlo.

En la documentacién del producto se emplea de forma sinénima el
término CUIDADO.

Las palabras de sefal corresponden a la definicion habitual para aplicaciones civiles en el area
economica europea. Pueden existir definiciones diferentes a esta definicidon en otras areas econémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefal aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacion del producto y
solamente en combinacién con el producto correspondiente. La utilizacién de las palabras de senal en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.

1. Sino se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicion de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccion IP 2X, grado de suciedad 2, categoria de sobrecarga eléctrica 2, uso
solamente en estancias interiores, utilizacion hasta 2000 m sobre el nivel del mar, transporte hasta
4500 m sobre el nivel del mar. Se aplicara una tolerancia de £10 % sobre el voltaje nominal y de
+5 % sobre la frecuencia nominal.

2. No situe el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacion del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacién de modo distinto al indicado en la documentacién del producto, pueden
causarse lesiones o incluso la muerte.

3. No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.
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Informaciones elementales de seguridad

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

10.

11.

Antes de la puesta en marcha del producto se debera comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion moévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcion intencionada del conductor de proteccion, tanto en la toma de
corriente como en el mismo producto. La interrupcién puede tener como consecuencia el riesgo de
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacion de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, se debera considerar
el enchufe del cable de conexién como interruptor. En estos casos se debera asegurar que el enchufe
siempre sea de facil acceso (de acuerdo con la longitud del cable de conexion, aproximadamente

2 m). Los interruptores de funcion o electronicos no son aptos para el corte de la red eléctrica. Si los
productos sin interruptor estan integrados en bastidores o instalaciones, se debera colocar el
interruptor en el nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacion adecuadas, de que el cable de conexién a red no pueda ser danado o de que nadie
pueda ser danado por él, p. €j. al tropezar o por un choque eléctrico.

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizaciéon de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tensidon Ug; > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. €j. medios de medicién adecuados, seguros, limitaciéon
de tension, corte protector, aislamiento etc.).

Para la conexiéon con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.
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12.

13.

14.

15.

16.

17.

18.

Informaciones elementales de seguridad

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacion y
la conexion deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafnos.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningin objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacion contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafos en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacién de tension (p. ej. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningun concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.

Funcionamiento

1.

2.
3.

4.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados, los llamados alérgenos
(p. €j. el niquel). Si durante el manejo de productos Rohde & Schwarz se producen reacciones
alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la conjuntiva o
dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las causas y
evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecanica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacion”, punto 1.
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5.

Informaciones elementales de seguridad

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacién de evaluar y sefializar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias toxicas
(gases, liquidos etc.) que pueden generar dafos a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. e€j. mascaras antigas e indumentaria de proteccion.

En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcién aparte de las descritas en la
documentacién del producto, a fin de evitar lesiones (p. €j. debidas a irradiacion laser).

Reparaciéon y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparaciéon deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicion de resistencia de aislamiento, medicién de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe seguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafo seco Y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Mantener baterias y celdas fuera del alcance de los nifios. En caso de ingestién de una celda o
bateria, avisar inmediatamente a un médico.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.
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Informaciones elementales de seguridad

6. En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la

piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevaciéon adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. ej. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafos personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafos.

Eliminacion

1.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacion adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacion de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.
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Kundeninformation zum Batteriegesetz (BattG)

Dieses Gerat enthalt eine Batterie bzw. Akkumulator. Die-
se durfen nicht mit dem Hausmull entsorgt werden.

Nach Ende der Lebensdauer darf die Entsorgung nur tber
eine geeignete Sammelstelle oder eine Rohde & Schwarz-
Kundendienststelle erfolgen.

Beachten Sie unbedingt die Hinweise zu Batterien und
Akkumulatoren in den grundlegenden Sicherheitshinwei-
sen.

Safety Regulations for Batteries (according to BattG)

This equipment houses a battery or rechargeable battery that may not be disposed of as
normal household waste.

After its useful life, the battery or rechargeable battery may only be disposed of at a
suitable depot or at a Rohde & Schwarz customer service center.

Always follow the instructions on batteries and rechargeable batteries in the basic safety
instructions.

Informacion para el cliente relativa a la Ley de Baterias (BattG)

Este equipo contiene una bateria o0 acumulador, que no se deben desechar en los con-
tenedores de basura domésticos.

Después de la vida util, la bateria solo se podra eliminar en un depdsito apropiado o en
un centro de atencién al cliente de Rohde & Schwarz.

Le rogamos que respete escrupulosamente las indicaciones referidas a baterias, acu-
muladores contenidas en las instrucciones de seguridad elementales.

Consignes de sécurité pour batteries (selon la loi BattG)

Cet appareil contient des batteries (piles, batteries et accumulateurs) qui ne doivent pas
étre jetées dans une poubelle pour ordures ménageres.

Une fois usagées, elles doivent étre éliminées dans un centre de collecte agréé ou un
centre de service clients de Rohde & Schwarz.

Veillez a respecter scrupuleusement les consignes de sécurité fondamentales concer-
nant les piles, batteries et accumulateurs.
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Customer Information Regarding Product Disposal

The German Electrical and Electronic Equipment (ElektroG) Act is an implementation of
the following EC directives:

e 2002/96/EC on waste electrical and electronic equipment (WEEE) and
e 2002/95/EC on the restriction of the use of certain hazardous substances in
electrical and electronic equipment (RoHS).

Product labeling in accordance with EN 50419

Once the lifetime of a product has ended, this product must not be disposed of
in the standard domestic refuse. Even disposal via the municipal collection
points for waste electrical and electronic equipment is not permitted.

Rohde & Schwarz GmbH & Co. KG has developed a disposal concept for the
environmental-friendly disposal or recycling of waste material and fully assumes its
obligation as a producer to take back and dispose of electrical and electronic waste
in accordance with the ElektroG Act.

Please contact your local service representative to dispose of the product.

ROHDE&SCHWARZ
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Qualitatszertifikat
Certificate of quality
Certificat de qualité

Sehr geehrter Kunde,

Sie haben sich fur den Kauf eines
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein
nach modernsten Fertigungsmethoden
hergestelltes Produkt. Es wurde nach
den Regeln unseres Qualitatsmanage-
mentsystems entwickelt, gefertigt
und gepruft. Das Rohde &Schwarz-
Qualitadtsmanagementsystem ist u.a.
nach ISO9001 und ISO 14001
zertifiziert.

Der Umwvelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche Weiterentwicklung
nachhaltiger Umweltkonzepte

1 1ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear Customer,

You have decided to buy a
Rohde & Schwarz product. You are
thus assured of receiving a product
that is manufactured using the most
modern methods available. This
product was developed, manufactured
and tested in compliance with our
quality management system stan-
dards. The Rohde & Schwarz quality
management system is certified
according to standards such as
ISO9001 and ISO 14001.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

11SO 14001-certified environmental
management system

Certified Quality System

IS0 9001

Certified Environmental System

1S0 14001

Cher client,

Vous avez choisi d'acheter un pro-
duit Rohde & Schwarz. Vous disposez
donc d'un produit fabriqué d'apreés les
méthodes les plus avancées. Le déve-
loppement, la fabrication et les tests
respectent nos normes de gestion
qualité. Le systeme de gestion qualité
de Rohde &Schwarz a été homologué,
entre autres, conformément aux nor-
mes ISO9001 et ISO 14001.

Engagement écologique

1 Produits a efficience énergétique

1 Amélioration continue de la durabilité
environnementale

1 Systeme de gestion de I'environne-
ment certifié selon ISO 14001
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CE Declaration of Conformity

Certificate No.: 2011-13

This is to certify that:

Equipment type Stock No. Designation
ZNC3 1311.6004.12 VECT.NETW.ANALYZER 2 PORT

complies with the provisions of the Directive of the Council of the European Union on the
approximation of the laws of the Member States

- relating to electrical equipment for use within defined voltage limits
(2006/95/EC)

- relating to electromagnetic compatibility
(2004/108/EC)

Conformity is proven by compliance with the following standards:

EN 61010-1: 2001

EN 61326-1: 2006

EN 61326-2-1: 2006

EN 55011: 2007 + A2: 2007, class A

EN 61000-3-2:2006 +A1:2009 + A2:2009
EN 61000-3-3:2008

For the assessment of electromagnetic compatibility, the limits of radio interference for Class
A equipment as well as the immunity to interference for operation in industry have been used
as a basis.

ROHDE & SCHWARZ GmbH & Co. KG
Miihldorfstr. 15, D-81671 Miinchen

Munich, 2011-04-20 Central Quality Management GF-QP / Chadzelek

1311.6004.12 CE E-1



Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00


mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com

R&S® ZNC Contents
Contents

1 Documentation Map.......c..coooiiieeciiiiiecccr s e 7
1.1 Getting Started GUIde........ ... ——————— 7
1.2 User Manual..........cooiiiiiiiiiieirs s s 7
1.3 Help SyStem...... e e 7
1.4 Documentation CD-ROM..........coooiiiimiiiiirr s s 7
2 Putting the Analyzer into Operation.........cccceeeeeeccciiiiiiirree e 8
2.1 Unpacking and Checking the Instrument...............oriimriiiiiiiiiieeeereee e 8
2.2 Positioning the InsStrument.............ooo oo 9
20 T =7=Y 0 Uod N oY o T 0 = - 1 £ o T PR 9
2.4 Operation in @ 19" RACK........ccccicccciiienecrrrrr s rs s ssssssnr e e s e e e e s s s smmnnn e e e e e e e s 10
2.5 EMI SUPPIESSION......cuueeeeciiiriiirriirsisssssssss s ssssmssmss s e s e e e e e resseesssssassssssssssnnnnnssnssnnnennnnes 10
2.6 Connecting the Analyzer to the AC SUPPIY....ccccccceciririiriisnemneeeeeeerrrr e 1
2.7 Power on and Off......ccccciiiiiimii 11
2.8 Standby and Ready State............ccccciiiciiiiicrrr e 1
3 INStrumMent TOUN......... s s 12
3.1 Front Panel TOUN........i et 12

N Tt I I 010 e 1~ 1= o PRSP 13
Tt I 1= (N o TN )£ TSP PPR 13
3.1.3  Data ENtry KeYS. ..o oottt 14
314 ROArY KNOD.....eecee et e e n 15
315 NaAVIGAtioON KEYS.....oiiiiiiiiiiii ettt e et e e s e e e s nnneeeaan 15
B G IS £= g Vo | o)V < SO 16
3.1.7  Front Panel CONNECIOrS. .......oouiiiiiie et n 16
3.2  Rear Panel TOUN..... ... s s s 17
3.3 Startup and ShutdoWnN...........ccciiiiiii e ——————— 18
3.4 Connecting External ACCESSOIIES.......cccurririiiriinmirriiierr e s 20
3.4.1  CoNNECNG @ IMOUSE.......eeiiiiiiiitie ettt e e e e e s e nneaeeeean 20
3.4.2 Connecting @ Keyboard...........ooo i 20
3.4.3  ConNecCting @ PriNter.. ... 21
3.4.4  ConNeCtiNng @ MONITOL. ....ooiiiiiiiei e e e 21
3.4.5 Connecting @ LAN Cable........cooiiiiiiiiieie e 22

Getting Started 1316.2407.02 — 06 3



R&S® ZNC Contents

4 Performing Measurements..........ccccooiiiiiinnenmmeeeerrr 23
41 Transmission S-Parameter Measurement............cccceiiiimmmniininnnnsne e 23
4.1.1 Connecting the Instrument for Transmission Measurements.................cccccccvvvvveeeenen.n. 24
4.1.2 Selecting the Sweep Range and Other Parameters..............ccccccoeviiiiie 25
4.1.3 Calibrating the INStrumMENt...........ooooii i 26
4.1.4 EVvaluating Datal ......cceeiiiiiieeie e a e 28
4.1.5 Savingand Printing Data ... 29
4.2 Reflection S-Parameter Measurement............ccccocnivieimnnnnin e 30
5 Operating the Instrument...............oooriiiiiii s 32
5.1 Touchscreen and Front Panel Operation..........ccccccimmiinciimnneeen e 32
5.2 Working wWith Dialogs.........cccciiiiiiimimiiiir s 36
5.3 Handling Diagrams, Traces, and Markers.........c.cccocvvmmmrinniiemnnnnsnnssne e 37
5.3.1 Adding New Traces and Diagrams............cooiiiiiiiiiiiiiie e 37
5.3.2  AddING NEW MATKETS. ... ..oiiiiiiiiiiiiiie ettt e s e e s nneeee s 38
5.3.3 Deleting Display EIEmENnts..........cooooiiiiiiiiii e 39
5.3.4  USING Drag and Drop.......ocuueeeieiiiiiieeiee ettt 40
5.4 Entering Data........cccceiiiiiemimiiiiii e 40
5.4.1  UsiNg Front Panel KEYS.........cooi ittt 41
5.4.2 Using the NUMErC EQItOr...........eoiiiiiiiiiie e 41
5.4.3 Using the Analyzer's On-Screen Keyboard.............cc.eeeiiiiiiiiiiiiiiiiieee e 42
5.4.4 Using the Windows® On-Screen Keyboard...............cooveieeeiceieciee e 43
5.5 Scaling Diagrams........ccccueeeeserrrrrrssssrrerrssssssrersssssssssesssssssssmeessssssssnsessssssssnsessssssssnnenes 44
5.5.1  Using the GraphiC ZOOM...........uuiiiiiiiiiiiiiee ettt e e s ee e e e s snnnaeeee s 44
5.5.2 Setting the SWEEP RANGE......cccciiiiiieiiiie et aeee s 45
5.5.3 Reference Value and POSItioN...........coiiiiiiiiiiiii e 45
L T U | (o oz [ TR 46
5.5.5  CirCUIAr DIiagramS........ccceiiiiueiiieieeiiiiieeiee e e s et ee e e e s et e eeaeesssssaeeeaessasnsaeeeaeesannsneeeen 46
5.5.6 Using Marker FUNCONS..........ooiii et e e e e 46
5.5.7 ENIarging @ Diagram........oooo oot a e e e e e e e e e aaaaaaaaaaaan 48
6 Administrative Tasks.........ccccommmmemmmcriiiniir s 49
6.1 Windows Operating System..........cccciiminimminni s 49
6.2 Firmware Update.........ccccoimmiiminieirer s 50
6.3 Remote Operation in @ LAN........ccccoiiiimiinr s 50

]
Getting Started 1316.2407.02 — 06 4



R&S® ZNC Contents

6.3.1  AsSIGNING @n [P AdAIESS.....cco e i aaaaaaaa e 51
6.3.2 Remote Deskiop CONNECHON............cooiiiiii e a e 53
6.3.3  WiIndows® Firewall SEttNGS..........ccceeviiriiiiiieiieiieieieieiee ettt ere e ens 54
7 MainteNaNCe......ccoveeeiiiriirir s 56
7.1 Storing and Packing the Instrument...............ciiiiiicccccr e 56
7.2 Replacing FUSES..... . 56
8 Obtaining Technical SUPPOrt........cceeeeiiiiiiirrc e 57

3 T (=1 58

Getting Started 1316.2407.02 — 06 5






R&S® ZNC Documentation Map

Getting Started Guide

1 Documentation Map

The R&S ZNC documentation is delivered as a printed Getting Started guide and a doc-
umentation CD-ROM providing the complete user documentation. In addition, a help
system is embedded in the instrument.

1.1 Getting Started Guide

The Getting Started guide describes everything that is needed to put the instrument into
operation and helps you to get familiar with the R&S ZNC. It gives an introduction to the
instrument's operating concept and provides simple measurement examples. A printed
Getting Started guide is delivered with each R&S ZNC.

1.2 User Manual

The User Manual complements the Getting Started guide, providing a detailed description
of the instrument's capabilities, examples and reference information for manual and
remote control. The User Manual is available on the documentation CD-ROM; the most
recent version is available for download on the R&S ZNC product pages on the R&S
internet.

1.3 Help System

The help system is embedded in the instrument, offering quick, context-sensitive refer-
ence to the information needed for operation and programming. It comprises the complete
information of the Getting Started guide and the User Manual.

You can use the help also if you control the instrument from an external monitor. Fur-
thermore you can transfer the help to your PC and use it as a standalone help.

1.4 Documentation CD-ROM

The CD-ROM contains the complete user documentation for the R&S ZNC:
e the help system

e the quick start guide in printable form

e the user manual in printable form

e brochures and data sheets in printable form

e the service manual in printable form

e links to different useful sites in the R&S internet
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R&S® ZNC Putting the Analyzer into Operation

Unpacking and Checking the Instrument

2 Putting the Analyzer into Operation

This section describes the basic steps to be taken when setting up the analyzer for the
first time.

Simple measurement examples are reported in chapter 4, "Performing Measure-
ments", on page 23; for a description of the operating concept refer to chapter 5,
"Operating the Instrument”, on page 32. For all background and reference information
concerning manual and remote control of the instrument refer to your analyzer's help
system or user manual. A more detailed description of the hardware connectors and
interfaces is also part of the help system or user manual.

A WARNING

Risk of injury and instrument damage

The instrument must be used in an appropriate manner to prevent electric shock, fire,
personal injury, or damage.

e Do not open the instrument casing.

e Read and observe the "Basic Safety Instructions" at the beginning of this manual or

on the documentation CD-ROM, in addition to the safety instructions in the following
sections. Notice that the data sheet may specify additional operating conditions.

Risk of instrument damage during operation

An unsuitable operating site or test setup can cause damage to the instrument and to
connected devices. Ensure the following operating conditions before you switch on the
instrument:

e All fan openings are unobstructed and the airflow perforations are unimpeded. The
minimum distance from the wall is 10 cm.

e The instrument is dry and shows no sign of condensation.

e The instrument is positioned as described in the following sections.

e The ambient temperature does not exceed the range specified in the data sheet.
e Signal levels at the input connectors are all within the specified ranges.

e Signal outputs are correctly connected and are not overloaded.

2.1 Unpacking and Checking the Instrument

Check the equipment for completeness using the delivery note and the accessory lists
for the various items. Should you notice any damage, immediately contact the carrier who
delivered the instrument.
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R&S® ZNC

Putting the Analyzer into Operation

Positioning the Instrument

ON\ Packing material

/ Retain the original packing material. If the instrument needs to be transported or shipped

at a later date, you can use the material to protect the control elements and connectors.

Risk of instrument damage during transportation and shipment

Insufficient protection against mechanical and electrostatic effects during transportation
and shipment can damage the instrument.

e Always make sure that sufficient mechanical and electrostatic protection is provided.

e When shipping an instrument, the original packaging should be used. If this is not
available, allow for sufficient padding to prevent the instrument from moving around
inside the box. Pack the instrument in antistatic wrap to protect it from electrostatic
charging.

e Secure the instrument to prevent any movement and other mechanical effects during
transportation.

The carrying handles at the front are designed to lift or carry the instrument. Do not
apply an excessive external force to the handles.

2.2

Positioning the Instrument

The network analyzer is designed for use under laboratory conditions, either on a bench
top or in a rack. Notice the general ambient conditions at the operating site described
under "Risk of instrument damage during operation" on page 8.

Risk of electrostatic discharge

Electrostatic discharge (ESD) can cause damage to the electronic components of the
DUT and the analyzer. ESD is most likely to occur when you connect or disconnect a
device under test (DUT) or test fixture to the analyzer's test ports.

To prevent ESD, use a wrist strap and cord and connect yourself to the ground connector
on the rear panel of the R&S ZNC. For additional information refer to the "Instructions for
Electrostatic Discharge Protection" on the R&S ZNC documentation CD-ROM.

2.3

Bench Top Operation

If the analyzer is operated on a bench top, the surface should be flat. The instrument can
be used in horizontal or vertical position, standing on its feet, or with the support feet on
the bottom expanded.
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Operation in a 19" Rack
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2.4 Operationin a 19" Rack

The R&S ZNC can be mounted in 19" racks using the adapter R&S ZZA-KN5 (order
number 1175.3040.00). Proceed according to the mounting instructions supplied with the
rack adapter.

Risk of instrument damage in a rack

An unsufficient airflow can cause the instrument to overheat, which may disturb the oper-
ation and even cause damage.

Make sure that all fan openings are unobstructed, that the airflow perforations are unim-
peded, and that the minimum distance from the wall is 10 cm.

2.5 EMI Suppression

To suppress generated electromagnetic interference (EMI), operate the instrument only
while it is closed, with all shielding covers fitted. Note the EMC classification in the data
sheet.

Use appropriate shielded cables to ensure successful control of electromagnetic radiation
during operation, especially for the following connector types:

o BNC rear panel connectors (EXT. TRIGGER OUT, EXT TRIGGER IN, REF OUT,
REF IN): Use double shielded cables and terminate open cable ends with 50 Q.

e USER PORT: Use only double shielded cables or disconnect the input pins of the
USER PORT connector in order to avoid spurious input signals which may cause
undesirable events. This is of particular importance if the external trigger input (pin
no. 2) is used.

e USB: Use double-shielded USB cables and ensure that external USB devices comply
with EMC regulations.

e GPIB (IEEE/IEC 625): Use a shielded GPIB cable.
e LAN: Use CATG6 or CAT7 cables.

The use of external accessories for the network analyzers may introduce additional con-
nector, cable, and cable length requirements. Refer to the relevant documentation.
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Connecting the Analyzer to the AC Supply

2.6 Connecting the Analyzer to the AC Supply

The network analyzer is automatically adapted to the AC supply voltage. The supply
voltage must be in the range 100 V to 240 V; 50 Hz to 60 Hz. The mains connector is
located in the upper part of the rear panel.

» Connect the network analyzer to the AC power source using the AC power cable
delivered with the instrument.

The maximum power consumption and the typical power consumption of the individual
analyzer models are listed in the data sheet.

The R&S ZNC is protected by two fuses located in the fuse drawer below the AC power
switch; see chapter 7.2, "Replacing Fuses", on page 56.

2.7 Power on and off

The AC power switch is located in the upper part of the rear panel, together with the mains
connector and the fuse drawer.

» To turn the power on or off, switch the AC power switch to position | (On) or 0 (Off).

After power-on, the analyzer automatically goes to standby or ready state, depending on
the state of the standby toggle key at the front panel when the instrument was switched
off last time.

The AC power switch can be permanently on. It is recommendable, however, to switch
it off if the instrument is not used for some time. Observe the instructions for startup and
shutdown in chapter 3.3, "Startup and Shutdown", on page 18.

2.8 Standby and Ready State

[=X=1 The standby toggle key is located in the bottom left corner of the front panel.

(O | e |n standby state, the right, amber LED is on. The standby power only supplies the
power switch circuits. In this state it is safe to switch the AC power off and disconnect
the instrument from the power supply.

e In ready state, the left, green LED is on and all modules are power-supplied. When
switched to ready state, the analyzer initiates its startup procedure.

It is recommendable to switch the vector network analyzer to standby state or power it
off if it is not used for some time. Observe the instructions for startup and shutdown in
chapter 3.3, "Startup and Shutdown", on page 18.

]
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3 Instrument Tour

This chapter gives an overview of the control elements and connectors of the R&S ZNC
and gives all information that is necessary to put the instrument into operation and con-
nect external devices. Notes on reinstallation of the R&S ZNC software appear at the end

3.1

of the chapter.

Front Panel Tour

Front Panel Tour

The front panel of the network analyzer consists of the touchscreen with the diagrams

and softtool panels (left side), the hardkey area (right side) and the test port area below.
Brief explanations on the controls and connectors, the hardkey area and the rear panel
can be found on the next pages.
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Fig. 3-1: Front View of R&S ZNC 3

Instrument damage caused by cleaning agents

Cleaning agents contain substances that may damage the instrument, e.g. cleaning
agents that contain a solvent may damage the front panel labeling or plastic parts.

Never use cleaning agents such as solvents (thinners, acetone, etc), acids, bases, or

other substances.

The outside of the instrument can be cleaned sufficiently using a soft, lint-free dust cloth.

Getting Started 1316.2407.02 — 06
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Front Panel Tour

Touchscreen

The analyzer is equipped with a 12.1" XGA color touchscreen. The touchscreen presents
all measurement results, mostly in the form of diagrams. Besides, all instrument functions
can be accessed and operated by tapping the control elements on the touchscreen. For
an introduction to touchscreen operation, refer to chapter 5.1, "Touchscreen and Front
Panel Operation”, on page 32.

The following sections contain further useful information about manual control of the R&S
ZNC.

e Refer to the other sections in chapter chapter 5, "Operating the Instru-
ment", on page 32 to learn how to handle traces and diagrams, and how to use
menus, keys and softtools.

e Referto chapter "Concepts and Features" in the user manual or help system to obtain
information about the results in the diagram.

e Refer to section "Display Menu" in the user manual or help system to learn how to
customize the screen.

o Refer to the data sheet for the technical specifications of the display.

Screen saver

The screen saver function of the operating system can be used to switch off the display
if the analyzer receives no command for a selectable period of time. The display is
switched on again if any front panel key is pressed.

To enable the screen saver, access the Windows® operating system (e.g. by pressing
the Windows key in the SUPPORT keypad) and tap "Control Panel > Hardware and
Sound > Power Options > Edit Plan Settings > Turn off the display".

3.1.2

TRACE

Setup Keys

The keys in the TRACE, CHANNEL, STIMULUS, and SYSTEM keypads call up groups
of related measurement settings. Each key corresponds to a softtool tab or a function of
the graphical user interface.

The TRACE keys give access to all trace settings, to the limit check settings, and to the
marker functions including marker search.

The MEAS settings select the measured and displayed quantity.
e The FORMAT settings define how the measured data is presented in the diagram.

e The SCALE settings define how the active trace is displayed in the diagram selected
via FORMAT.

e The TRACE CONFIG settings store traces to the memory and perform mathematical
operations on traces.

e The LINES settings define limits for the measurement results, visualize them in the
diagrams and activate/deactivate the limit check.

e The MARKER settings position markers on a trace, configure their properties and
select the format of the numerical readout. Markers can also be used to locate specific
points on the trace, define the sweep range, and scale the diagram.
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SHANBEL The CHANNEL keys give access to the hardware-related (channel) settings.

PEea .

The POWER BW AVG settings define the power of the internal signal source, the IF
bandwidth, and the sweep average.

The SWEEP settings define the scope of measurement, including the sweep type
and the number of measured sweeps.

CAL provides all functions that are necessary to perform a system error correction
(calibration).

CHANNEL CONFIG provides functions for channel management.
The TRIGGER settings control the start of the measurement sequence.

OFFSET EMBED provides a selection of length offset parameters to shift the mea-
surement plane.

STIMILES START CENTER or STOP SPAN define the sweep range, depending on the sweep type.

The SYSTEM keys provide general system settings.

FILE provides standard Windows® functions used to create, save, recall or print recall
sets, to copy the active screen and to shut down the application.

The PRINT settings control an external printer that is used to print a hardcopy of the
current recall set.

APPLIC gives access to external software tools.

DISPLAY gives access to all display settings and to the functions which activate,
modify and arrange different diagrams.

SETUP provides general system settings which are not restricted to a particular recall
set.

The Windows® key opens the startup menu of the Windows® operating system from
where you can perform system configurations and call up additional software utilities.

HELP opens the context-sensitive help system of the analyzer.
PRESET performs a preset of the instrument settings.

3.1.3 Data Entry Keys

BACK-
SPACE ENTER

The keys in the DATA ENTRY keypad are used to enter numbers, units, and characters.
The data entry keys are only enabled while the cursor is placed on a data input field in a
dialog or in the Help navigation pane.

The keys 0 to 9 enter the corresponding numbers.

The function of the "." and "-" keys depends on the data type of the active input field:
— In numeric input fields, the keys enter the decimal point and a negative sign for
the entered numeric value. Multiple entries have not effect.

— In character input fields, the keys enter a dot and a hyphen, respectively. Both
entries can be repeated as often as desired.

The function of the four unit keys depends on the data type of the active input field;
see chapter 5.4, "Entering Data", on page 40.
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— In numeric input fields, the G/n, M/y, k/m or x1 keys multiply the entered value
with factors of 106)°, 1008, 1063 or 1 and add the appropriate physical unit. x1 is
equivalent to ENTER and confirms the previous entry.

— Incharacter input fields, the G/n, M/, k/m keys enter the letters G, M, K, respec-
tively. x1 is equivalent to ENTER and confirms the previous entry.

e ESCis used to:
— Cancel entries / close dialogs without activating the entries made (equivalent to
the "Close" button).

— Close the Help system.

e ENTER is used to:
— Activate the selected active control element, e.g. a button in a dialog or a link in
the "Contents" page of the Help system.

— Confirm selections and entries made and close dialogs (equivalent to the "OK"
button).

— Compress or expand menus or the Help table of contents

o BACKSPACE deletes the last character before the cursor position or the selected
character sequence or numeric value.

Rotary Knob

The rotary knob increases and decreases numerical values, scrolls within lists, activates
controls and confirms entries. Turning or pressing the rotary knob is equivalent to the
action of the "Cursor Up" and "Cursor Down" navigation keys or of the ENTER key in the
DATA ENTRY keypad, respectively.

STEP SIZE opens an input box to select the steps (in units of the current physical param-
eter) between two consecutive numerical values. The step size is also valid for value
changes using the "Cursor Up" and "Cursor Down" keys. See also chapter 5.4.2, "Using
the Numeric Editor", on page 41.

Navigation Keys

The keys in the NAVIGATION keypad are used to navigate within the touchscreen and
the help system, to access and control active elements.
The "Cursor Up" and "Cursor Down" keys are used to:

e Scroll up and down in lists, e.g. among menu items, in a list of keywords, in the Help
table of contents, or in the Help index

e Navigate between table rows in diagrams. Press "OK" to toggle between navigation
mode and data entries.

e Increase and decrease numerical input values

"Cursor Up" (Down) become inactive as soon as the beginning of the list is reached.
"Cursor Up" (Down) is equivalent to a rotation of the rotary knob to the right (left).

The "Cursor Left" and "Cursor Right" keys are used to:
e Move the cursor to the left or right within input fields

]
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3.1.71

Front Panel Tour

e Navigate between table columns in diagrams. Press "OK" to toggle between navi-
gation mode and data entries.

e Compress or expand menus or the Help table of contents
e Move the highlighted item in the menu bar of the active application

ENT OK is equivalent to the action of the ENTER key in the DATA ENTRY keypad.

UNDO reverses the last action, if possible. REDO reverses the action of the UNDO but-
ton.

Standby Key

The standby toggle switch is located in the bottom left corner of the front panel.

The key serves two main purposes:

® Toggle between standby and ready state; see chapter 2.8, "Standby and Ready
State", on page 11.

e Shut down the instrument; see chapter 3.3, "Startup and Shutdown", on page 18.

Front Panel Connectors

The test ports and four USB connectors are located on the front panel of the analyzer.

Test Ports

N-connectors numbered 1, 2 ... The test ports serve as outputs for the RF stimulus signal

and as inputs for the measured RF signals from the DUT (response signals).

e With a single test port, it is possible to generate a stimulus signal and measure the
response signal in reflection. For a measurement example refer to chapter 4.2,
"Reflection S-Parameter Measurement", on page 30.

e With 2 test ports, itis possible to perform full two-port measurements; see chapter4.1,
"Transmission S-Parameter Measurement", on page 23.

Maximum input levels

The maximum input levels at all test ports according to the front panel labeling or the data
sheet must not be exceeded.

In addition, the maximum input voltages of the other input connectors at the rear panel
must not be exceeded.

i

It is recommended to use a torque wrench when screwing RF cables on the test port
connectors. Standard IEEE 287 specifies a torque of (1.5 £ 0.2) Nm for N connectors.
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3.1.7.2 USB Connectors
Four high speed Universal Serial Bus connectors of type A (master USB), used to connect

e.g a keyboard, mouse or other pointing devices, the Calibration Unit (accessory R&S
ZV-Z5x), a printer or external storage devices (USB stick, CD-ROM drive etc.).

(==~ gl —

The length of passive connecting USB cables should not exceed 1 m. The maximum
current per USB port is 500 mA. See also chapter 2.5, "EMI Suppression", on page 10.

3.2 Rear Panel Tour

This section gives an overview of the rear panel controls and connectors of the network
analyzer.

REFER TO THE SERVICE MANUAL BEFORE REMOVING THIS MODULE

® SYSTEM DRIVE
00 NOT REMOVE DURING DFERATION

The following connectors are available on all instruments:

e AN is an RJ-45 connector. Use this connector to integrate the instrument to a Local
Area Network, primarily for remote control purposes; see chapter 6.3, "Remote Oper-
ation in a LAN", on page 50.

¢ MONITOR (DVI-D) is an external monitor connector; see chapter 3.4.4, "Connecting
a Monitor", on page 21.

e USERPORT is a 25-pin D-Sub connector used as an input and output for low-voltage
(3.3 V) TTL control signals.

e EXT TRIG IN and EXT TRIG OUT are two BNC connectors for low-voltage (3.3 V)
TTL external trigger signals.

]
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e REF OUT is a BNC output for the internal reference frequency of the R&S ZNC. Use
this connector to synchronize other instruments to the analyzer.

e REF IN is a BNC input for an external reference frequency. Use this connector to
synchronize the R&S ZNC to another device.

e SYSTEM DRIVE contains the removable system hard disk of the R&S ZNC, con-
taining all software (including the operating system and the VNA application) and
data. No other hard disk is built in. Do not remove the disk during operation.

e The ground connector in the lower left corner of the rear panel provides the ground
of the analyzer's supply voltage. Use this connector for ESD protection; see "Risk of
electrostatic discharge" on page 9.

The following optional connectors can be installed in addition:

e Option R&S ZNC-B10 provides a GPIB bus connector according to standard IEEE
488/ IEC 625.

Input levels, EMC

The maximum input levels and voltages of the input connectors at the front and rear panel
must not be exceeded.

Use double shielded cables at the BNC rear panel connectors (EXT. TRIGGER OUT,
EXT TRIGGER IN, REF OUT, REF IN) and match signals with 50 Q in order to comply
with EMC directives! See also chapter 2.5, "EMI Suppression", on page 10.

3.3

Startup and Shutdown

To start the analyzer, proceed as follows:

1. Make sure that the instrument is connected to the AC power supply and switch the
AC power switch on the rear panel to position | (On).

2. If necessary, press the standby toggle key on the front panel to switch the instrument
to ready state (the green LED goes on).

Tthe analyzer automatically performs a system check, boots the Windows® operating
system and then starts the network analyzer (VNA) application. If the last analyzer ses-
sion was terminated regularly, the VNA application uses the last recall set with all instru-
ment settings.

To shut down the analyzer, proceed as follows:

1. Press the standby key to save the current recall set, close the VNA application, shut
down Windows®, and set the instrument to standby state. Of course you can also
perform this procedure step by step like in any Windows session.

2. If desired, set the AC power switch to position 0 (Off).

]
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Risk of data loss

It is strongly recommended to switch the analyzer to standby state before disconnecting
it from the AC supply. If you set the power switch to 0 while the VNA application is still
running, you will lose the current settings. Moreover, loss of program data can not be
excluded if the application is terminated improperly.

Minimizing the VNA application

With a minimized VNA application, you can access your analyzer's Windows® desktop
or run other applications. To start the VNA application with a minimized window on a
continuing basis, right-click the VNA shortcut icon on the desktop and open the "Prop-
erties" dialog. In the "Shortcut" tab, select "Run: Minimized".

&> Vector Network Analyzer Properties IEI

| General | Shortout |Cc|mpalibi\ity| Security | Details | Frevious \/ersiun5|

@ “ector Network Analyzer

Target type: Application

Targetlocation:  Bin

Target: de-5 sctor Metwork Ana

Startin:

Shortcut key: MNone

Fun: [Normalwindow V]
Comment:
Open File Location ] ’ Change lcon... ] ’ Advanced... ]
[ O J ’ Cancel ] Apply

After a software update the VNA application is started with a maximized window again.
Moreover, if a second VNA application is started after a first, minimized application, this
will cause the first application to appear in the foreground.
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3.4 Connecting External Accessories

The equivalent USB ports of the analyzer can be used to connect a variety of accessories:

e A mouse simplifies operation of the instrument using the controls and dialogs of the
Graphical User Interface (GUI).

e A keyboard simplifies the entry of data.

e A printer generates hard copies of the screen contents.

In addition the analyzer provides interfaces for monitor connection and network integra-

tion:

e An external monitor shows the magnified Graphical User Interface (GUI) with all dia-
grams and controls.

e A LAN connection can be established in order to access the hard disk or control the
analyzer from an external PC.

3.4.1 Connecting a Mouse
A USB mouse can be connected to any of the Universal Serial Bus connectors. The

mouse is detected automatically when it is connected. It is safe to connect or disconnect
the mouse during the measurement.

Mouse configuration

Use the "Start > Control Panel > Hardware and Sound > Devices and Printers >
Mouse" menu of Windows® to configure the mouse properties. To access Windows®,
press the Windows key on the external keyboard or on the front panel.

Operating the analyzer does not require a mouse. You can access all essential functions
by tapping the touchscreen and the keys on the front panel. Tapping a control element
for a short time corresponds to the action of the left mouse button. A longer touch (touch
and hold) simulates the right mouse button (e.g. for opening context menus). Tapping
twice (double-tap) corresponds to a double-click (e.g. for opening the on-screen key-
board).

3.4.2 Connecting a Keyboard

A keyboard can be connected to any of the Universal Serial Bus connectors. The key-
board is detected automatically when it is connected. The default input language is Eng-
lish — US. It is safe to connect or disconnect the external keyboard during the measure-
ment.

]
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Keyboard configuration

Use the "Start > Control Panel > Clock, Language, and Region > Region and Language
> Keyboards and Languages" dialog of Windows® to configure the keyboard properties.
To access Windows®, press the Windows key on the external keyboard or on the front
panel.

Operating the analyzer does not require a keyboard. You can access all essential func-
tions by tapping the touchscreen and the keys on the front panel.

3.4.3

Connecting a Printer

A printer can be connected to any of the Universal Serial Bus connectors.

It is safe to connect or disconnect the printer during the measurement. When printing a
copy (PRINT), the analyzer checks whether a printer is connected and turned on and
whether the appropriate printer driver is installed. If required, printer driver installation is
initiated using the operating system's "Add Printer Wizard". The wizard is self-explana-
tory. A printer driver needs to be installed only once, even though the printer may be
temporarily removed from the analyzer.

Printer driver installation

A great variety of printer drivers is available on the analyzer. To obtain the complete list,
access Windows® (press the Windows key) and open the "Start > Control Panel > Hard-
ware and Sound > Devices and Printers" menu.

You can load updated and improved driver versions or new drivers from an installation
disk, USB memory stick or another external storage medium. Alternatively, if the analyzer
is integrated in a network, you can install driver data stored in a network directory. In
either case, use the "Add Printer" wizard to complete the installation.

Printer configuration

Use the "Page Setup" dialog or the "Start > Control Panel > Devices and Printers" menu
of Windows® to configure the printer properties and printing preferences.

Connecting a Monitor

A standard monitor can be connected to the MONITOR (DVI-D) connector of the R&S
ZNC.

Safety aspects

The monitor must be connected while the instrument is switched off (or in standby mode).
Otherwise correct operation can not be guaranteed.
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The monitor displays the magnified analyzer screen with all diagrams, measurement
results and control elements. No extra configuration is required. With an additional mouse
or keyboard connected to the analyzer, you can control the measurement from the exter-
nal monitor. If desired, click "DISPLAY > View Bar > Hard Key Panel" to add the "Hard
Key Panel" to the analyzer screen.

3.4.5 Connecting a LAN Cable

A LAN cable can be connected to the LAN connector on the rear panel of the analyzer.
To establish a LAN connection proceed as follows:

1. Refer to section chapter 6.3.1, "Assigning an IP Address", on page 51 and learn
how to avoid connection errors.

2. Connect a CAT6 or CAT7 RJ-45 (LAN, Ethernet) cable to the LAN port.

The LAN port of the analyzer is an auto-crossover Ethernet port. You can connectit to a
network that is equipped with Ethernet hardware (hub, switch, router), but you can also
set up a direct connection to a computer or another test instrument. For both connection
types, you can use either crossover or standard straight-through Ethernet cables. The IP
address information is displayed in the "SETUP > Remote Settings" softtool panel.
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4 Performing Measurements

The following chapter presents a sample session with a R&S ZNC network analyzer and
explains how to solve basic tasks that you will frequently encounter when working with
the instrument.

CAUTION

Safety considerations

Before starting any measurement on your network analyzer, please note the instructions
given in chapter 2, "Putting the Analyzer into Operation", on page 8.

Use the "S-Parameter Wizard" accessible via "TRACE > MEAS > S-Params > S-Param
Wizard ..." to perform a standard S-parameter measurement in a straightforward way.
The wizard provides a series of dialogs where you can select the test setup, screen con-
figuration and measurement parameters, configure the essential channel settings and
perform a guided calibration.

Measurement stages in the wizard

The different dialogs of the "S-parameter Wizard" correspond to the typical stages of any
measurement:

1. Select the test setup
Define port impedances
Select the measurement parameters and the diagrams

2

3

4. Define the sweep range

5. Adjust the receiver and source settings (measurement bandwidth, source power)
6

Perform a calibration

ON In the following we assume that you tap the analyzer's touchscreen to access all instru-

/ ment functions. Refer to chapter 5.1, "Touchscreen and Front Panel Opera-

tion", on page 32 and chapter 5.4, "Entering Data", on page 40 to learn how to access
instrument functions and control dialogs by other means.

4.1

Transmission S-Parameter Measurement

In a transmission measurement, the analyzer transmits a stimulus signal to the input port
of the device under test (DUT) and measures the transmitted wave at the DUT's output
port. The trace settings allow you to select the measured quantities and display formats,
depending on what you want to learn from the data. A minimum of two analyzer test ports
are required for transmission measurements.
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In the following example, the analyzer is set up for a two-port transmission measurement.
A frequency sweep range is selected, the instrument is calibrated and the measurement
result is analyzed using various display formats.

41.1 Connecting the Instrument for Transmission Measurements

In order to prepare a transmission measurement, you have to connect your DUT (which
for simplicity we assume to have appropriate connector, e.g. male N 50 Q connectors)
in-between a pair of analyzer test ports. All test ports are equivalent for this measurement
and may be interchanged. It is recommended to preset the R&S ZNC in order to start
from a definite instrument state.

1 DUT 2

1. Connectthe DUT between test ports 1 and 2 of the network analyzer as shown above.

2. Proceed as described in chapter 3.3, "Startup and Shutdown", on page 18, to switch
on the instrument and start the VNA application.

3. Press the PRESET key in the SYSTEM keypad to perform a factory preset of the

analyzer.

@ The analyzer is now set to its default state. The default measured quantity is the trans-
mission S-parameter S,;.

Trc1 521'dB Mag 10 dB / Ref 0 dB
0 dB >
Start 100 kHz Pwr 210 dBm Stop 3 GHz!
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Press TRACE > TRACE CONFIG and use the control elements in the "Traces" softtool
panel if you wish to create a new trace or a new diagram.

4.1.2 Selecting the Sweep Range and Other Parameters

After preset the display shows a diagram with a dB Mag scale. The sweep range (scale
of the horizontal axis) is from 100 kHz to the maximum frequency of the analyzer, and
the S-parameter S, is selected as a measured quantity. This S-parameter is the forward

transmission coefficient of the DUT, defined as the ratio of the transmitted wave at the
DUT's output port (port no. 2) to the incident wave at the DUT's input port (port no. 1).

The R&S ZNC automatically adjusts its internal source and receiver to the selected mea-
sured quantities: For an S,y measurement, a stimulus signal (termed a,) is transmitted
at the analyzer port no. 1; the transmitted wave (termed b,) is measured at port 2. The
stimulus signal from the analyzer port no. 2 is not needed except for some calibration
types.

To gain some more insight into the transmission characteristics of your DUT you can
select a smaller sweep range.

1. Press STIMULUS > START and enter the lowest frequency you want to measure in
the "Start Frequency" input field (e.g. 1.77 GHz) of the opened softtool panel. For
convenient numeric entry, tap the input field twice to open the "Numeric Editor" dialog.

T EE ¥ | X

Start Frequency Step Size
~

10 MHz

Auto

Tip: If you use the DATA ENTRY keys at the front panel for data entry, simply type
1.77 and terminate the entry with the G/n key. Refer to chapter 5.4, "Entering
Data", on page 40 to learn more about entering numeric values and characters.

2. Tap the "Stop Frequency" input field (below "Start Frequency") and enter the highest
frequency you want to measure (e.g. 2.5 GHz).

3. Tap "TRACE > SCALE > Scale Values" and activate the "Auto Scale Trace" function.
The analyzer adjusts the scale of the diagram to fit in the entire S,, trace, leaving an

appropriate display margin.

]
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=
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Tip: Refer to chapter 5.5, "Scaling Diagrams", on page 44 to learn more about the
different methods and tools for diagram scaling.

4.1.3 Calibrating the Instrument

Calibration (system error correction) is the process of eliminating systematic, reproduci-
ble errors from the measurement results. E.g. in the current test setup, the connecting
cables between the analyzer ports and the DUT introduce an attenuation of the waves
on their way from the analyzer port 1 to the input of the DUT and from the DUT output to
the analyzer port 2. The non-zero length of the cables also introduces a phase shift of
the waves. Both effects impair the accuracy of the S-parameter measurement.

The analyzer provides a wide range of sophisticated calibration methods for all types of
measurements. Which calibration method is selected depends on the expected system
errors, the accuracy requirements of the measurement, on the test setup and on the types
of calibration standards available.

In the following we assume that the calibration kit R&S ZV-Z121 contains an appropriate
male Through standard ("Through (mm)") with known physical properties. With a single
Through, it is possible to perform a normalization, compensating for a frequency-depend-
ent attenuation and phase shift in the signal paths.

Due to the R&S ZNC's calibration wizard, calibration is a straightforward, menu-guided

process.
1. Replace the DUT by the Through (mm) standard from the calibration kit R&S ZV-
Z121.

2. Tap "CHANNEL > CAL > Start Cal (Manual)" to open the "Calibration Presetting"
dialog.

3. Select the port combination Port 1 (P1) and Port 2 (P2) and the calibration type "Trans
Norm". Ensure that port 1 is defined as the source port.

]
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4. Tap "Next" to proceed to the next "Calibration Presetting" dialog. Select the test port
connector type and gender (here: N 50 Q, Female, corresponding to a male calibra-
tion standard) and the calibration kit (here: "ZV-Z121"), then click "Start".

Calibratiun B

Connectors and Cal Kits
Select connector type and gender for ports. If necessary, changed the

used Cal Kit or load an appropriate one
T I A
I o I o

Trans Norm : P1{Source), P2

N 50 Q

Female

cal Kit alucy

N 50

Q

Female

E¥-Z121

[ use Sliding Match

Same Connector

all Ports

Same Gender

all Ports

(- Back

. Import
cal Kit ...

b start X | Cancel @Help

The next dialog of the calibration wizard shows that only a single calibration standard

needs to be measured.
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5. Tap "Through (mm)" to initiate the measurement of the connected through standard.
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The analyzer performs a calibration sweep for the measured quantity S,;. The mag-
nitude and phase of the result is displayed in two diagrams, together with the expected
typical result for a through standard (red traces, hidden by the blue ones in our exam-
ple). The similarity of the red and the blue traces indicates that the Through standard
has been properly connected. After the R&S ZNC has completed the calibration
sweep and calculated the correction data, the "Apply" button is available.

6. Click "Apply" to close the wizard and apply the system error correction to the current
measurement. A "Cal" label appears in the trace list.

7. Remove the Through standard and connect the DUT again.

4.1.4 Evaluating Data

The analyzer provides various tools to optimize the display and analyze the measurement
data. For instance, you can use markers to determine maxima and minima on the trace,
and change the display format to obtain information about the group delay of the trans-
mitted wave.

1. Tap "TRACE > MARKER > Mkr 1". This places "Marker 1" to its default position
(center of the sweep range).
A marker symbol (triangle) appears on the trace. The stimulus value (frequency) and
response value (magnitude of the transmission coefficient converted to a dB value)
at the marker position is displayed in the marker info field in the upper right corner of
the diagram.
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2. Select the "Marker Search" softtool tab and activate "Min" search.
The marker jumps to the absolute minimum of the curve in the entire sweep range.
The marker info field shows the coordinates of the new marker position.

3. Tap "TRACE > FORMAT" and select the "Delay" of the transmission coefficient as
displayed quantity.

The group delay represents the propagation time of the wave through the DUT; it is
displayed in a Cartesian diagram. The marker info field shows the frequency and
group delay at the marker position.

Trcl 521 'Delay 1 ns/ Ref0's Cal

+ M1 2.135000 GHz 241,229 ps

M1
h 4

Em Start 1.77 GHz Pwr -10 dBm Bw 10 kHz Stop 2.5 GHz/

Refer to section "Display Formats and Diagram Types" in the help system or in the user
manual to learn more about the diagram properties.

41.5

Saving and Printing Data

The analyzer provides standard functions for saving measurement settings and for saving
or printing the results. You can use these functions as if you were working on a standard
PC. Moreover you can export your trace data to an ASCII file and reuse it in a later session
or in an external application.

@

Data transfer is made easier if external accessories are connected to the analyzer or if
the instrument is integrated into a LAN. Refer to chapter 3.4, "Connecting External
Accessories", on page 20, and chapter 6.3, "Remote Operation in a

LAN", on page 50 to obtain information about the necessary steps.

1. Tap "TRACE > TRACE CONFIG > Trace Data > Export...".
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In the "Export Data" dialog opened, select the file type *.csv. Enter a file location
("Look in:") and file name and tap "Save".
The active trace data is written to an ASCII file.

Tap "SYSTEM > PRINT > Print Now" to create a hardcopy of your diagram.

Select "To File..." or "To Clipboard" to copy the diagram to a file or an external appli-
cation.

Tap "SYSTEM > FILE > Setup > Save...".

In the "Save" dialog opened, enter a file location and name and tap "Save".
The active recall set containing your instrument settings is stored to a file and can be
used again in a later session.

Proceed as described in chapter 3.3, "Startup and Shutdown", on page 18 to shut down
your analyzer.

Reflection S-Parameter Measurement

In a reflection measurement, the analyzer transmits a stimulus signal to the input port of
the device under test (DUT) and measures the reflected wave. A number of trace formats
allow you to express and display the results. depending on what you want to learn from
the data. Only one analyzer test port is required for reflection measurements.

In principle a reflection measurement involves the same steps as a transmission mea-
surement. Note the following differences:

The basic test setup for reflection measurements involves a single DUT and analyzer
port. For instance, you can connect the input of your DUT to port 1 of the analyzer
as shown below.

DUT 2

You can also use the basic transmission test setup, e.g. if you want to measure
reflection and transmission parameters in parallel.

]
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The analyzer provides special calibration types for reflection measurements. Use the
calibration wizard and select an appropriate type. The full n-port calibration types
(TOSM, UOSM, TNA ...) will correct the system errors for all transmission and reflec-
tion S-parameters.

Some of the trace formats are particularly suited for reflection measurements. E.g.
you can display the measured reflection coefficient S in a Smith chart in order to
obtain the complex input impedance at port no. 1.

Trcl 511'Smith 200 mU/ Ref 1 U Cal Off

1:M_\ (135000 GHz 19,852 @
2 jli.145 @
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5 Operating the Instrument

The following sections describe how to solve basic tasks that you will frequently encoun-
ter when working with the instrument. In particular you can learn how to access instrument
functions and control dialogs without a mouse and/or keyboard.

Customizing the screen

The contents of the screen and the size and position of many display and control elements
are not fixed. You can display or hide most elements. You can also drag and drop traces,
info fields, and even the softtool panel to your preferred position; see chapter 5.3.4, "Using
Drag and Drop", on page 40.

5.1 Touchscreen and Front Panel Operation

You can access all control elements of the vector network analyzer by tapping the
touchscreen and the keys on the front panel. The following examples are intended to
make you familiar with touchscreen and front panel key operation.

The analyzer functions are arranged in softtool panels and dialogs. Front panel keys open
the most frequently used panels. This provides quick access to the instrument settings,
avoiding complicated menu structures and long operating sequences. The control ele-
ments in the softtool panels can be accessed in different alternative ways.

Using front panel keys

To access an instrument function via front panel keys,

1. Press the front panel key, e.g. the MEAS key in the TRACE panel.

The corresponding softtool panel appears on the right side of the touchscreen.
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2. Tap the desired softtool tab, e.g. "Z <-- Sij".

Z— 5

= | 5 m Params

s s Ratios
[ —S11 2-512
L L J

i i Wave
[ Z—521 2522
L. PN v

— e 2—Sij

Balanced Ports

¥ Sij

3. Tap the control element, e.g. "Z <-- S11".
The diagram immediately shows the result of your setting. In the present example,
the active trace shows the converted impedance parameter Z,,.

A control element with three dots (e.g. "System Config...") opens a dialog with a group
of related settings.

]
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Using the menu bar

The menu bar across the bottom of the touchscreen provides an alternative access to
all instrument functions. To repeat the "Z<-S11" setting described above,

» Tap "Trace > Meas > Impedance > Z<-S11".

The diagram immediately shows the result of your setting. At the same time, the
related softtool tab is opened.

5
Params

Ratios

Using context menus
Context menus are another alternative for quick access to instrument settings. To repeat
the "Z<-S11" setting described above,

1. Touch and hold the measured quantity section in the trace list for a couple of seconds
until the context menu appears.

]
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2. Tap "S-Parameter" to open the "Meas > S-Params" softtool panel.
Meas X

S-Parameter 5-
| S5 Params

Ratios

2+ Sij

all
S-Params
¥—Sij
S-Param
Wizard... Y- z-
B ————— Params
Balanced Ports

Imbal.

stability

Power
Sensor

DC

3. Tap "Impedance > Z <-- S11".

Meas X

[
Params

Ratios

The following table shows possible touchscreen operations with the corresponding
mouse operations.

]
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Touchscreen

Mouse

Typical task

Tap control element for a short time

Click control element (left mouse button)

Select button or softtool tab

Tap for an extended time (tap and hold)

Click (right button)

Open context menu

Tap twice (double-tap)

Double-click (left button)

Open on-screen keyboard

5.2 Working with Dialogs

Dialogs provide groups of related settings and allow to make selections and enter data
in an organized way. The settings are visualized, if possible. An example is shown below.

G:Q Colibpaiion Mresinins

Ports and Type

Select the ports to be calibrated and the tye of the calibration

- POFO

Trans Norm : P1{Source), P2

) )

Refl Norm
Open

Refl Norm
Short

—_
—_

Afp— J

One Path
Two Ports

Trans
Norm Both

3o ) ¢
r— —

TOM TSM

Source

Calibrate
Port 1

all channels

* Back

-) Next I.?lll::ancel @Help

All dialogs are operated in a similar way.

To open a dialog, tap a softtool button with three dots behind its labeling (e.g. "Start

Use the "Transparency" function to obtain a transparent dialog which you can control
while viewing the underlying traces and display elements.

Drag and drop the hatched triangle in the lower right corner to modify the size of a

Some dialogs are subdivided into tabs, containing groups of related settings. Tap on
a tab to access the settings.

[ ]
Cal (Manual) ...").
[ ]
[
diagram.
[ ]
[ ]

Tap "OK" to activate the current settings and close the dialog, "Cancel" to discard all
changes.
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e The Help system provides useful information about each dialog's specific settings.
Tap "Help" to open the Help.

5.3 Handling Diagrams, Traces, and Markers

The analyzer displays measurement results as traces in rectangular diagrams. Markers
are used to read specific numerical values and to search for points or regions on a trace.
The following section will make you familiar with some of the graphical tools which the
R&S ZNC provides for trace and marker handling.

For further reference
Refer to chapter "Concepts and Features" in the R&S ZNC Help or in the User Manual
to learn more about traces, channels, and screen elements.

5.3.1 Adding New Traces and Diagrams

A new trace is needed if you want to measure and display an additional quantity.

Typical scenario: The transmission coefficient S, is measured as described in chap-

ter 4.1, "Transmission S-Parameter Measurement", on page 23. A trace is added to dis-
play the reflection coefficient Sy, for comparison.

[ i New To create a new trace,

WG] 1 Drag and drop the "New Trace" icon in the toolbar above the diagram area into a
diagram.

The diagram changes its color scheme and contents as shown below. A rectangle
with diagonal lines divides the diagram into different sectors.

2. Select the sector, depending on whether you want to display the new trace in the
existing diagram, or whether you want to add a new diagram.

]
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3. Inthe dialog box that is opened when you release the "New Trace" icon, select an S-
parameter to display.

@ | [—

Select S-Parameter for the
new trace

511 s12

521 522

The R&S ZNC generates a new trace for the selected S-parameter.

Alternative control elements

The "TRACE > Trace Config" softtool tab provides more functions for trace handling. The
"DISPLAY > Display > Diagram" softtool tab provides function for efficient diagram han-
dling.

To add a trace for an arbitrary measured quantity (e.g. a ratio, wave, impedance, or
admittance parameter), you can open the tabs of the "TRACE > Meas" softtool and simply
drag and drop the corresponding softkeys into a diagram area.

5.3.2 Adding New Markers

A marker is needed e.g. if you want to read a particular numerical trace value.

New To add a new marker,
AN "IEiA:1d e Drag and drop the "New Marker" icon in the toolbar above the diagram area to the

desired position.

The marker appears on the active trace. The marker info field displays the stimulus
value (x-axis value) and response value (y-axis value) at the marker position. The
response value varies as the analyzer continues performing sweeps.

]
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Alternatively, any marker offered in "TRACE > Marker > Markers" softtool tab can be
positioned on the active trace by Drag&Drop.

@ Active trace, alternative control elements

The trace line of the active trace in the upper part of the diagram is highlighted. If the
diagram contains several traces, first click a trace or a trace line to select the active trace,
then add a marker.

The "TRACE > Marker > Markers" softtool tab provides more functions for marker han-
dling.

5.3.3 Deleting Display Elements

Markers, traces, diagram areas, and other display elements are most conveniently
deleted using the "Delete" icon in the toolbar above the diagram area.
e To delete a single marker, drag it into vertical direction to release it from the trace
and drop it onto the "Delete" icon.
To delete a set of markers, drag and drop their marker info field onto the "Delete"
icon. You can delete all types of marker info fields, including e.g. the info fields for a

bandfilter search.
Deleting a marker and its info field also disables the associated marker function.

e To delete a trace, drag and drop its trace line onto the "Delete" icon.
e To delete a channel, drag and drop all associated traces onto the "Delete" icon.

e To hide the limit lines and disable the limit check, drag and drop the PASS / FAIL
message onto the "Delete" icon. The limit line itself is not deleted; you can re-use it
any time.

e To delete a diagram area, drag and drop the diagram number label in the upper right
corner onto the "Delete" icon.

The context menu of some display elements (e.g. markers) also provides the "Delete"
function.
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Undo function
If you happen to delete a display element unintentionally, you can simply restore it using
the UNDO key or the "Undo" icon in the toolbar.

5.3.4 Using Drag and Drop

You can drag and drop many of the R&S ZNC's control and display elements in order to
change their size and position. The drag and drop functionality is often more convenient
to use than the equivalent buttons of the softtool panels. The following table gives an
overview.

Table 5-1: Drag and drop functionality for various screen elements

Screen element Action Drag and drop...

Diagram Create "New Trace" icon --> existing diagram; see chapter 5.3.1, "Adding New Traces and
Diagrams”, on page 37

Re-size Frame (shaded bar in-between adjacent diagrams)

Delete Diagram number label ---> "Delete" icon; see chapter 5.3.3, "Deleting Display Ele-
ments", on page 39

Trace Create "New Trace" or "New Ch + Tr" icon --> existing diagram; see chapter 5.3.1, "Adding
New Traces and Diagrams", on page 37

Move vertically Reference line marker (right diagram edge)

Move into other or new | Trace line

diagram
Delete Trace line --> "Delete" icon; see chapter 5.3.3, "Deleting Display Ele-
ments", on page 39
Reset / suspend "Graphic Zoom" element in additional trace line --> "Delete" icon; see chapter 5.5.1,
graphic zoom "Using the Graphic Zoom", on page 44
Marker Create "New Marker" icon --> existing diagram; see chapter 5.3.2, "Adding New Mark-
ers", on page 38
Move horizontally Marker symbol
Delete Marker or marker info field --> "Delete" icon; see chapter 5.3.3, "Deleting Display
Elements", on page 39
Marker info field Add / delete See marker above (the info field is always tied to a marker)

Move within diagram Marker info field (move to one of several pre-defined positions)

Softtool area Move Softtool area (move to the right or left edge of the screen)

5.4 Entering Data

The analyzer provides dialogs with various types of input fields where you can enter
numeric values and character data. Data entry with a mouse and an external keyboard

]
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5.4.2

Entering Data

is a standard procedure known from other Windows® applications. However, there are
various other ways to enter data.

Using Front Panel Keys

You can use the keys in the DATA ENTRY keypad to enter numbers, units, and charac-
ters.

To enter a numeric value
1. Tap a numeric data input field to activate it.

2. Press the DATA ENTRY keys.

e Use "0" to "9" to enter the corresponding numbers.
e Use "." and "-" to enter a decimal point or change the sign of the value.
e Use "G/n", "M/p", "k/m", or "x1" to multiply the entered value with factors of

1009, 1068, 10018 or 1 and add the appropriate physical unit.

To enter a character string
1. Tap a character data input field to activate it.

2. Press the DATA ENTRY keys as if you were writing a short message on your mobile
phone.

e Press "0" to "9" once to enter the corresponding numbers.

e Use "." or "-" to enter a dot or a hyphen.

e Use "G/n", "M/u", or "k/m" to enter the letters G, M or K (case-insensitive).

e Use the BACKSPACE key to correct wrong entries, deleting the character to the
left of the current cursor position.

Press ENTER to complete an entry.

Press ESC CANCEL to discard the entries made.

3. To enter letters other than G, M or K, you can also use one of the methods described
in the following sections:

e chapter 5.4.3, "Using the Analyzer's On-Screen Keyboard", on page 42
e chapter 5.4.4, "Using the Windows® On-Screen Keyboard", on page 43

Using the Numeric Editor

The "Numeric Editor" is a tool for convenient entry and modification of numeric values. It
is available for all numeric input fields in the "Vector Network Analyzer" (VNA) application.
Operation with touchscreen or mouse:

1. Double-tap or double-click to activate a numeric input field in a dialog or in a softtool
panel and open the numeric editor.
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_Start Frequency _ Step Size )

10 MHz

Auto

2. Tap on the buttons in the numeric keypad to compose the numeric input value.

3. If desired, select a "Stepsize" and use the cursor up/down buttons to increment/dec-
rement the current value. If a marker is active, you can also set the numeric value to
the current marker value ("Set to Marker").

4. After completing the input string tap "Enter" to apply your selection and close the
numeric editor.

STEP SIZE key

If a numeric input field is active, the STEP SIZE front panel key to the right of the rotary
knob opens a dialog box containing the "Step Size" panel of the numeric editor. Use this
box for efficient operation of the rotary knob.

5.4.3 Using the Analyzer's On-Screen Keyboard

The on-screen "Keyboard" allows you to enter characters, in particular letters, without an
external keyboard. It is available for all character input fields in the "Vector Network Ana-
lyzer" (VNA) application.

Operation with touchscreen:

1. Double-tap to activate a character data input field in a dialog or in a softtool panel
and open the on-screen keyboard.

]
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2. Tap the buttons to select the characters for the input string.

3. After completing the input string tap "Enter" to apply your selection and close the
keyboard.

Operation with a mouse:
1. Double-click a character data input field to open the on-screen keyboard.

2. Click a sequence of characters and "Enter" to apply your selection and close the
keyboard.

5.4.4 Using the Windows® On-Screen Keyboard

The Windows® on-screen keyboard allows you to enter characters, in particular letters,
even if an input field cannot call up the analyzer's own on-screen keyboard. Examples
are input fields in standard Windows ® dialogs.

& On-Screen Keyboard (=@ &3]

i o Sl G i .

To call up the on-screen keyboard,

1. Press the Windows key in the SUPPORT keypad to access Windows® and open the
start menu.

2. If you do not find the "On-Screen Keyboard" in the start menu, tap "All Programs >
Accessories > Ease of Access > On-Screen Keyboard".
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The "APPLIC - External Tools" submenu contains a shortcut to the Windows® on-screen
keyboard. Simply click "Screen Keyboard" to open the keyboard.

5.5 Scaling Diagrams

The analyzer provides many alternative tools for customizing the diagrams and for setting
the sweep range. Choose the method that is most convenient for you.

5.5.1 Using the Graphic Zoom

The graphic zoom function magnifies a rectangular portion of the diagram (zoom window)
to fill the entire diagram area. The sweep points are not affected.
r'." To activate the graphic zoom,

LY o Tap the "Zoom Active Trc" icon in the toolbar above the diagram area.
The icon changes its color as shown on the left side.

e To define the zoom window, tap on one corner, then move your finger across the
touchscreen until you have reached the diagonal corner.

The zoom function is executed as soon as you release the touchscreen. The zoom
window is zoomed in both horizontal and vertical direction. In general, the zoomed
diagram shows only part of the sweep range; the distance between the displayed
sweep points increases.

While the zoom function is active for a particular trace, an additional trace line below the
channel line indicates the zoomed stimulus range. You can repeat the graphic zoom for
different traces in the diagram and assign independent zoom windows, as shown in the
example below.

Wik Start 100 kHz i Pwir -10 dBm Stop 3 GHz
Start 8§26.321971 MHz — Graphic Zoom Stop 2.320312 GHz
| Tre2 Start 981.655861 MHz — Graphic Zoom Stop . 1.084197 GHz,

[}l To restore the original size of the diagram and display the entire sweep range, tap the

s "toggle zoom" icon. You can tap the icon repeatedly to change between the zoomed and
unzoomed view. Alternatively, you can drag and drop the "Graphic Zoom" element in the
additional trace line onto the "Delete" button.
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Alternative settings

The "toggle zoom" icon opens the "TRACE > Scale > Zoom" where you can refine the
displayed zoom range using numeric entries. To zoom the stimulus range and change
the sweep point spacing so that the number of displayed sweep points is maintained, use
"STIMULUS > Stimulus > Zoom Stimulus".

Refer to the R&S ZNC Help or User Manual for details.

5.5.2 Setting the Sweep Range

The sweep range for all channels is displayed in the channel list across the bottom of the
diagram:

- - Time Domain Stop. 4ns |

To change the sweep range, use one of the following methods:

e Press either the START and STOP keys or the CENTER and SPAN keys in the
STIMULUS keypad.

e Tap and hold the start or stop value in the channel list for some seconds (with a
mouse: right-click) and select "Start Frequency", "Stop Frequency", "Center Fre-
quency", "Frequency Span" from the context menu.

e Select "Start Frequency", "Stop Frequency", "Center Frequency", "Frequency
Span" from the "Channel > Stimulus > Stimulus™ menu.

e Use the marker functions ("TRACE > MARKER > Marker Function"; see chap-
ter 5.5.6, "Using Marker Functions", on page 46).

5.5.3 Reference Value and Position

The analyzer provides three parameters for changing the scale of the vertical (response)

axis:

e Changing the "Ref Value" or "Ref Position" shifts the trace in vertical direction and
adjusts the labels of the vertical axis. "Ref Value" also works for radial diagrams.

e Changing the "Scale/Div" modifies the value of the vertical or radial diagram divisions
and thus the entire range of response values displayed.

The "Scale/Div" and the "Ref Value" are indicated in the scale section of the trace list. In
the example below, a "Scale/Div" of 10 dB and a "Ref Value" of 0 dB is used.

(Trcl' 521 'dB'Mag 10 dB / Ref 0 dB Math'|

To change one of the parameters use one of the following methods:
e Tap "TRACE > SCALE > Scale Values" to access the settings in the softtool tab.

e Tap and hold the scale section in the trace list for some seconds (with a mouse: right-
click) and select the settings from the context menu.
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5.5.4

5.5.5

Scaling Diagrams

e Select the settings from the "Trace > Scale > Scale Values" menu.

e Use the marker functions ("TRACE > MARKER > Marker Funct"; see chapter 5.5.6,
"Using Marker Functions", on page 46).

Auto Scale

The "Auto Scale" function adjusts the scale divisions and the reference value so that the
entire trace fits into the diagram. To access "Auto Scale", use one of the following meth-
ods:

e Tap "TRACE > SCALE > Scale Values" to access the "Auto Scale..." settings in the
softtool tab.

e Tap and hold the scale section in the trace list for some seconds (with a mouse: right-
click) and select "Auto Scale Trace" from the context menu.

e Select "Auto Scale..." from the "Trace > Scale > Scale Values" menu.

Circular Diagrams

The radial scale of a circular ("Polar", "Smith" or "Inverted Smith") diagram can be
changed with a single linear parameter, the "Ref Value". The reference value defines the
radius of the outer circumference.

e Increasing the "Ref Value" scales down the polar diagram.
e Decreasing the "Ref Value" magnifies the polar diagram.

The "Ref Value" is indicated in the scale section of the trace list.

To change the "Ref Value" use one of the following methods:
e Tap "TRACE > SCALE > Scale Values" to access the parameter in the softtool tab.

e Tap and hold the scale section in the trace list for some seconds (with a mouse: right-
click) and select the parameter from the context menu.

e Select the parameter from the "Trace > Scale > Scale Values" menu.

e Use the marker functions; see chapter 5.5.6, "Using Marker Func-
tions", on page 46.

The "Auto Scale" function also works for polar diagrams.

5.5.6

Using Marker Functions

Marker functions are a convenient tool for scaling (in particular: magnifying) diagrams
without entering explicit numeric values. You simply place a marker to a trace point and
use the marker values to change the sweep range or move the trace relative to the vertical
axis. The touchscreen or a mouse makes it easier to activate (touch/click) or move (drag
and drop) markers.

]
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To set the sweep range use one of the following methods.

Define "Start" and "Stop" values:

1.

2.
3.

Create two normal markers, e.g. the markers Mkr 1 (M1) and Mkr 2 (M2), and place
them to the desired start and stop values of the sweep range.

Activate "M1" and tap "TRACE > MARKER > Marker Function > Start = Marker".
Activate "M2" and tap "TRACE > MARKER > Marker Function > Stop = Marker".

Use a definite "Span:"

1.

Create a marker and set it to delta mode.
The analyzer automatically creates a reference marker in addition to the delta marker.

Place the reference marker to the desired start value of the sweep range.
Set the value of the delta marker equal to the desired (positive or negative) span.

Activate the delta marker and tap "TRACE > MARKER > Marker Function > Span =
Marker".

To move the trace relative to the vertical axis proceed as follows:

1.

Create a normal marker, e.g. the marker Mkr 1 (M1), and place it to a particular trace
point. E.g. you can use the "Marker Search" functions to locate a maximum or mini-
mum on the trace.

Tap "TRACE > MARKER > Marker Function > Max = Marker" to move the trace
towards the upper diagram edge, leaving the values of the vertical divisions ("Scale/
Div") and the overall vertical scale unchanged. Analogously, tap "Min = Marker" to
move the trace towards the lower diagram edge, or tap "Ref Val = Marker" to move
the trace towards the "Ref Value".

]
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You can also use marker values in the "Numeric Editor" dialog; see chapter 5.4.2, "Using
the Numeric Editor", on page 41.

5.5.7 Enlarging a Diagram

The analyzer provides different tools for customizing the contents and size of the dia-
grams:

e Tapping a diagram twice (or a double click on any point in the diagram) enlarges the
diagram to occupy the whole window.

e The "Menu Bar", "Status Bar", "Hard Key Panel", and the "Title Bar" are optional
display elements which you can hide in order to gain space for the diagrams ("DIS-
PLAY > View Bar").

e "DISPLAY > Config" provides optional display elements for the interior of the dia-
grams.

Use the context menu of the diagram, the DISPLAY key or the "Display" menu to access
the display settings.
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6 Administrative Tasks

This chapter describes various topics which you may need only occasionally or in case
that you desire a special instrument configuration.

6.1 Windows Operating System

The analyzer is equipped with a Windows® 7 operating system which has been configured
according to the instrument's features and needs. Changes in the system configuration
can be necessary in order to:

e Establish a LAN connection
e Customize the properties of the external accessories connected to the analyzer
e Call up additional software tools

Modifications of the operating system

The operating system is adapted to the network analyzer. To avoid impairment of instru-
ment functions, only change the settings described in this manual. Existing software must
be modified only with update software released by Rohde & Schwarz. Likewise, only

programs authorized by Rohde & Schwarz for use on the instrument must be executed.

The "Start" menu of the operating system is accessed by pressing the Windows key in
the SYSTEM keypad or on an external keyboard. All necessary settings can be accessed
from the "Start" menu, in particular from the "Control Panel".

N\ User accounts and password protection

/ The analyzer uses a user name and password as credentials for remote access. Two
user accounts with different levels of access are available on the instrument:

e instrument" is the default account with standard rights to change system settings.
Use this account for normal operation of the analyzer.

e "Administrator” is the account for administering the operating system. This account
is required e.g. if you wish to install programs on the analyzer.

In the factory configuration, "894129" is preset as a password for both users. To protect
the analyzer from unauthorized access, it is recommended to change the factory setting
("Control Panel > User Accounts > Change your password").

To change from one user account to the other, press the Windows key in the SYSTEM
keypad, open the start menu, and select "Shut down > Switch User". The user accounts
of your R&S ZNC are displayed as shown below.

]
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6.2

Firmware Update

Administrator instrument

Firmware Update

Upgrade versions of the analyzer firmware are supplied as single setup files *.msi.

i

Administrator account

You need administrator rights to install a new firmware version. See note on "User
accounts and password protection" on page 49 for details.

To perform a firmware update,

1. Copy the setup file to any storage medium accessible from the analyzer. This may
be the internal hard disk, an external storage medium (USB memory stick, external
CD-ROM drive) or a network connection (LAN, GPIB bus).

2. In the Windows® Explorer, tap the setup file twice (or double-click with a mouse) and
follow the instructions of the setup wizard.

Setup files can be stored and installed again. The default drive name of the internal hard
disk is C:. External storage devices are automatically mapped to the next free drive, i.e.
D:, E: etc.

Factory calibration
A firmware update does not affect the factory calibration.

External accessories

The calibration unit (accessory R&S ZV-Z5x) must be disconnected during a firmware
update.

6.3

Remote Operation in a LAN

A LAN connection is used to integrate the analyzer into a home/company network. This
offers several applications, e.g.:

e Transfer data between a controller and the analyzer, e.g. in order run a remote control
program.

]
Getting Started 1316.2407.02 — 06 50



R&S® ZNC Administrative Tasks

Remote Operation in a LAN

e Control the measurement from a remote computer using Remote Desktop or a similar
application.

e Use external network devices (e.g. printers).

Virus protection

An efficient virus protection is a prerequisite for secure operation in the network. Never
connect your analyzer to an unprotected network because this may cause damage to the
instrument software. For useful hints refer to the application note 1EF73_OE, which is
available at:

http://www.rohde-schwarz.de/de/service_support/downloads/application_notes?
type=20&downid=5699

The analyzer uses a user name and password as credentials for remote access; see note
on "User accounts and password protection" on page 49 for details. To protect the ana-
lyzer from unauthorized access, it is recommended to change the factory setting.

6.3.1 Assigning an IP Address

Depending on the network capacities, the TCP/IP address information for the analyzer
can be obtained in different ways.

e If the network supports dynamic TCP/IP configuration using the Dynamic Host Con-
figuration Protocol (DHCP), all address information can be assigned automatically.

e If the network does not support DHCP, or if the analyzer is set to use alternate TCP/
IP configuration, the addresses must be set manually.

By default, the analyzer is configured to use dynamic TCP/IP configuration and obtain all
address information automatically. This means that it is safe to establish a physical con-
nection to the LAN without any previous analyzer configuration.

Administrator account
You need administrator rights to change the TCP/IP configuration. See note on "User
accounts and password protection" on page 49 for details.

Manual TCP/IP configuration

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before you connect the analyzer
to the LAN. Contact your network administrator to obtain a valid IP address, because
connection errors can affect the entire network.

]
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To disable dynamic TCP/IP configuration and enter the TCP/IP address information
manually proceed as follows:

1. Obtain the IP address and subnet mask for the analyzer and the IP address for the
local default gateway from your network administrator. If needed, also obtain the
name of your DNS domain and the IP addresses of the DNS and WINS servers on
your network.

2. Pressthe Windows key in the SYSTEM keypad or on an external keyboard to access
Windows®.

3. Open the "Control Panel > Network and Internet > Network and Sharing Center >
Local Area Connection Status" dialog.

4. Tap "Properties" and confirm the user account control message, depending on your
current user account.

e If your current account is an administrator account, click "Yes".
e |f your account is an account with standard user rights, enter the password of the
administrator account and click "Yes".

‘;‘ User Account Control @

Do you want to allow the following program to make

changes to this computer?

/&7y Programname:  Network Connections
-t Verified publisher: Microsoft Windows
File origin: Hard drive on this computer

To continue, type an administrator password, and then click Yes.

Administrator

| Password

Smart card error
The card supplied requires drivers t...

V Show details Yes l l fig

Fig. 6-1: Windows 7 User Account Control dialog

5. Inthe "Local Area Connection Properties” dialog opened, select "Internet Protocol
Version 4 (TCP/IPv4) > Properties" and enter the IP address information, e.g.:
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Internet Protocol Wersion 4 (TCP/IPw4) Properties @
Gereral

You can get IP setings assigned automatically if your network supports
this capability, Ctherwise, you need to ask your network, administrator for
the appropriate IP settings.

() Obtain an IP address automatically

(@) Use the following IP address:

[P address: g9 . 10 . 48 | &2
Subret mask: 255, 0 .0 .0
Default gatevray: g2 . 0 .0 . g

Obtain DMS server address automatically

(@) Use the following DMS server addresses:

Preferred DMS server: 192,168 . 133 . 4

Alternate DS server:

[T ] validate setfings Lpon exit

[ oK l I Cancel ]

6.3.2 Remote Desktop Connection

Remote Desktop is a Windows® application which you can use to access and control the
analyzer from a remote computer through a LAN connection. While the measurement is
running, the analyzer screen contents are displayed on the remote computer, and
Remote Desktop provides access to all of the applications, files, and network resources
of the analyzer.

For detailed information about Remote Desktop and the connection refer to the Win-
dows® Help.

To establish the connection proceed as follows:

1. Connect the R&S ZNC to the network; see chapter 3.4.5, "Connecting a LAN
Cable", on page 22.

2. Press the Windows button and open operating system's control panel.

3. Select "System and Security > System > Allow remote access" and open the
"Remote" tab in the "System Properties" dialog. Enable "Allow connections from
computers running any version of Remote Desktop".

You must confirm a user account control message to allow the desired changes (see
figure 6-1).

4. Tap "Select Users..." and ensure that "instrument" is added as a Remote Desktop
user.
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5. Tap "Control Panel > System and Security > Administrative Tools > Services". In the
list of local services opened, right-click "Smart Card" and select "Stop".

This will disable the smart card service of the network analyzer for the current session.

Tip: Do not attempt to disable the smart card service permanently. Otherwise you
have to re-logon as an administrator and re-enable the service in order to restore the
proper functioning of the analyzer and its options.

6. Determine the computer name ("Control Panel > Network and Internet > Network and
Sharing Center > Local Area Connection > Details") or IP address ("Control Panel >
System and Security > System > Set the name of this computer” or ipconfig com-
mand in the command prompt) of your R&S ZNC. See also chapter 6.3.1, "Assigning
an |IP Address", on page 51.

7. Click "Start > Programs > Accessories > Remote Desktop Connection" on your
remote computer. Establish a connection using the R&S ZNC's computer name or IP
address. You can also use other utilities providing remote PC access, e.g. VNC.

6.3.3 Windows® Firewall Settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. In the default configuration of the R&S ZNC the firewall is enabled.
A remote desktop connection does not require any changes in the firewall settings.

N\ Administrator account

_Y/ You need administrator rights to change the firewall settings. See note on "User accounts
and password protection" on page 49 above for details.

Some actions require a different firewall configuration, e.g.:

e To transfer data with other hosts in the LAN, you have to allow "File and Printer
Sharing".

To change the firewall settings proceed as follows:

1. Access the operating system by pressing the Windows® key on the external key-
board. Open the "Control Panel".

2. Select "System and Security > Windows Firewall".

e Tap "Change Settings > Allow a program or feature through Windows Firewall"
to enable "File and Printer Sharing".
e Tap "Turn Windows Firewall on or off" to enable or disable the firewall.

You must confirm a user account control message to allow the desired changes (see
figure 6-1). For detailed information about the firewall refer to the Windows® Help.
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Risks of changing the firewall settings

Disabling the firewall or allowing exceptions may make your instrument more vulnerable
to viruses and intruders. It is recommend to restore the default firewall configuration after
completing a task which requires modified settings.
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[/ Maintenance

The R&S ZNC vector network analyzer does not require any special maintenance.

For our support center address and a list of useful R&S contact addresses refer to the
documentation CD-ROM or the "Contact" page at the beginning of the Help system.

7.1 Storing and Packing the Instrument

The vector network analyzer can be stored at the temperature range quoted in the data
sheet. When it is stored for a longer period of time the unit should be protected against
dust.

The original packing should be used when the unit is to be transported or dispatched;
please also observe the notes in chapter 2.1, "Unpacking and Checking the Instru-
ment", on page 8.

7.2 Replacing Fuses

The instrument is protected by two time lag fuses (IEC60127 T3.15H / 250 V, stock no.
0099.6729.00), located in the fuse drawer below the AC power switch on the rear panel.

A WARNING

Shock hazard

Before replacing a fuse, make sure that the instrument is switched off and disconnected
from all power supplies.

Always use fuses supplied by Rohde & Schwarz as spare parts, or fuses of the same
type and rating.

To replace the fuses,

1. Use a small screwdriver to bend the small clamps on both sides of the fuse drawer
inward so that you can lift the fuse drawer out of its slot.

2. Exchange the fuses.

3. Push the drawer back into the slot.
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8 Obtaining Technical Support

The instrument generates error messages which in most cases will be sufficient for you
to detect the cause of an error and find a remedy. Error message types are described in
the R&S ZNC User Manual; refer to section "Error Messages and Troubleshooting".

In addition, our customer support centers are there to assist you in solving any problems
that you may encounter with your network analyzer. We will find solutions more quickly
and efficiently if you provide us with the information listed below. Simply open the relevant
dialogs in the "Info" dialog, tap Save..., and send us the file.

Setup Info: The instrument setup information ("Info > Setup Info") contains your
instrument settings. You can also send us the VNA recall set file (*.znx) that you
generate after the fault occurs ("File > Recall Sets > Save...").

Option Info: The option info ("Info > Option Info") informs us about the status of all
software and hardware options of your analyzer.

Hardware Info: The hardware info ("Info > Hardware Info") shows us the installed
options and hardware assemblies.

Error Log: The error log ("Info > Error Log") contains a chronological record of errors.

Save Report: The system report command ("Info > Save Report") collects the setup,
option, and hardware information as well as the error log and the current selftest
results and writes everything to a *.zip file. The *.zip file also contains the current
eeprom data and a screenshot of the VNA display. It is written to the report directory
C:\Users\Public\Documents\Vna\Report. The file name contains the current
date and time, e.g. report 20110125 1658.zip. "Save Report" provides the
most comprehensive information, comprising all other "Info" files.
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